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AKVIS WATERCOLOR 7.0 | AQUARELLE ART FROM PHOTOS

AKVIS Watercolor transforms images into watercolor art. The software lets you create brilliant and inspiring aquarelle
paintings in a click! Make your photos look like paintings!

You don't have to be an artist to enjoy painting. Use the artistic effects by AKVIS to create your works of art!

Watercolor painting is one of the oldest and most commonly used painting techniques in which color pigments are solvable in
water. Aquarelle paintings have a brilliant and luminous look based on the clarity and translucency of colors and the flowing
fluidity of lines.

Did you ever dream of creating your own masterpiece? Using AKVIS Watercolor you can imitate great masters without any
painting skills. You only need to adjust the settings to your taste and run the processing. Any ordinary image will turn into a
gorgeous aquarelle piece of art!
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AKVIS Watercolor includes two styles of photo to art conversion: Classic Watercolor and Contour Watercolor. Each
style comes with a set of ready-to-use presets and adjustable settings.

AKVIS Watercolor

4



The software lets you experiment with a wide range of painting genres: from vibrant marine paintings and atmospheric
landscapes up to impressive portraits and exquisite still lifes. See the gallery of examples created in the program.

The program is very user friendly and does not require any prior experience. It offers a number of ready-to-use presets that
can be used to imitate different watercolor techniques. Kick-start your creativity by trying different presets and paper colors!
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The software is equipped with a wide variety of creative features.

The Abstract Art effect, available for both styles, offers additional settings that turn any digital photo into a modern
abstract masterpiece. Bring a contemporary touch to your paintings using vivid colors and irregular shapes!
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You can make your work of art even more realistic using the Decoration tab. It allows you to imitate the texture of
watercolor paper, add a frame to your painting, or personalize your artwork with a signature.
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You can add the finishing touches to the painting using the Watercolor Brush and other post-processing tools.

The program supports the Batch Processing feature allowing you to save precious time when working with a series of
images.

AKVIS Watercolor is available as a standalone program and as a plugin to photo editors: AliveColors, Adobe Photoshop, Corel
PaintShop Pro, etc. Consult the compatibility page for more details.

The functionality of the program depends on the license type. During the trial period you can try all options and choose the
license you like.
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INSTALLATION

Follow the instructions to install AKVIS Watercolor on a computer with Windows OS:

Start the setup exe file.
Select your language and press the Install button.
To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

Press the Install button.
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The installation is in progress.

The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Watercolor.
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INSTALLATION

Follow the instructions to install AKVIS Watercolor on a Mac computer:

Open the dmg file:

- akvis-watercolor-app.dmg to install the Standalone version

- akvis-watercolor-plugin.dmg to install the Plugin into your image editor.

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS Watercolor application or AKVIS Watercolor PlugIn inside.

 

To install the Standalone version, drag the AKVIS Watercolor app into the folder Applications (or any other place
you like).

To install the Plugin, drag the entire AKVIS Watercolor PlugIn folder into the Plug-Ins folder of your graphic editor:

Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.

AKVIS Watercolor
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the Filter menu of your photo editor (in Photoshop: Filter ->
AKVIS -> Watercolor).

Run the standalone program by double-clicking on its icon in Finder.

You can also run the AKVIS program from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Watercolor and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.

AKVIS Watercolor
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Watercolor.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Your registration is completed!

AKVIS Watercolor
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).

 

AKVIS Watercolor

17



WORKSPACE

AKVIS Watercolor lets you transform a photograph into a watercolor painting. The software can be used independently as a
standalone program or in a photo editor as a plugin filter.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

The workspace is arranged according to the chosen interface mode: Parameters or Presets.

In the Parameters mode, the standard program window is visible.

AKVIS Watercolor Workspace (Parameters)

Click Presets in the top panel to switch to the presets visual display mode (Presets Gallery).

AKVIS Watercolor
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AKVIS Watercolor Workspace (Presets)

The left part of the AKVIS Watercolor workspace is taken by the Image Window with two tabs: Before and After. Under
the Before tab, you can see the original photo. The After tab shows the resulting image. You can switch between the
windows by left-clicking on the tab with the mouse button. To compare the original and the resulting images, click in the
image and hold the button pressed - the program will currently switch between tabs.

 

In the upper part of the program's window you can see the Control Panel with these buttons:

The button  opens the home page of AKVIS Watercolor.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac. 

Right mouse click this button to display the list of recent files. You can change the number of recent documents in the
program's preferences.
The button  (only in the standalone version) saves the image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P  on Windows,

⌘ +P  on Mac.

The button  loads a list of presets (.watercolor file).

The button  saves user presets to a file with the .watercolor extension.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  loads saved guiding lines (.direction file).

The button  saves the guiding lines to a .direction file.

The button  /  shows/hides the guiding lines.

The button  cancels the last operation (with the tools). It is possible to cancel several operations in a row. The

hotkeys are Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys

are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  initiates image processing with the current settings. The resulting image is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  shows information about the program: version, trial period, license.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Watercolor.
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To the left of the Image Window there is the Toolbar. Different tools appear on the Before/After tabs.

Pre-Processing Tools (in the Before tab):

The button  switches on/off the Quick Preview window.

The button  (only in the standalone version) activates the Crop tool which allows cutting off unwanted areas in the

image.
The button  activates the Stroke Direction tool used to draw the guiding lines changing direction of the brush

strokes (in the Classic Watercolor style for Home Deluxe and Business licenses).
The button  activates the Eraser tool used to remove or edit the guiding lines drawn with the Stroke Direction

tool.

Post-Processing Tools (in the After tab, for Home Deluxe and Business licenses):

The button  activates the Smudge tool which is used to manually refine images by removing paint irregularities.

The button  activates the Blur tool which reduces image sharpness by decreasing color contrast.

The button  activates the History Brush tool which lets you fade the watercolor effect and restore the image,

partially or fully, to its original state.
The button  activates the Watercolor Brush tool which lets you draw translucent watercolor strokes.

Additional Tools:

The button  activates the Hand tool which allows you to scroll the image when it does not fit within window at the

desired scale. To use it, click the icon, bring the cursor over the image, and while keeping the left mouse button
pressed move in the desired direction.
Double-clicking on the tool's icon  makes the image fit the window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in left click in the image. To zoom

out left click with Alt  on the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).

Under the Navigator, there is the Settings Panel where you can choose the painting style (Classic Watercolor or Contour
Watercolor) and its Presets, as well as tweak the parameters in the tabs:

Painting: Adjust the settings for the watercolor effect depending on the chosen style: Classic/Contour Watercolor.
Abstract Art: These additional settings allows you to create colorful artworks with whimsical and fantastic shapes.
Decoration (Text/Canvas/Frame): Add text, logo or watermark to your painting, adjust the canvas surface, and
apply a frame.

Under the settings, you can see Hints for the parameters and buttons when you hover over them with the cursor. You can
choose where the hints will be shown or hide them in the program's Preferences.
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HOW TO USE THE PROGRAM

AKVIS Watercolor turns a photo into a watercolor painting. The software can be used independently as a standalone
program or as a plugin filter in a photo editor.

To create a watercolor painting from your photo, follow these instructions:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click in the empty workspace of the program or with 
. Use the hot-keys: Ctrl+O  on Windows, ⌘ +O  on Mac. You can also drag the required image into the

workspace of the program. 
The standalone program supports JPEG, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open.

Call the plugin from the menu of the editor:

In AliveColors: Effects -> AKVIS -> Watercolor;
in Adobe Photoshop: Filter -> AKVIS -> Watercolor;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Watercolor;
in Corel Photo-Paint: Effects -> AKVIS -> Watercolor.

The workspace is arranged according to the chosen interface mode: Parameters or Presets.

AKVIS Watercolor Window

Step 2. In the standalone version, before applying the watercolor effect, you can cut off unwanted areas of the
picture and improve its composition with the Crop tool . If you use the plugin, you can do this in your image editor.
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Classic Watercolor

 

Contour Watercolor

Crop Tool

Step 3. In the Settings Panel, select a style of watercolor painting: Classic Watercolor or Contour Watercolor.

The Classic Watercolor style allows you to create aquarelle arts with transparent paints. Due to the variety of
settings, it's possible to imitate various painting techniques.

The Contour Watercolor style imitates a mixed method of painting, very close to the "dry-on-wet" watercolor
technique, with a combination of watercolor paint and pencils.

In the Painting tab, you can adjust the settings of the selected watercolor style.

Additionally, you can use the Abstract Art tab to change the shape and color of objects, giving them a unique and
fantastic look. This feature is available only for the Home Deluxe and Business licenses.

The result is immediately shown in the Quick Preview area.

AKVIS Watercolor
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Automatic Strokes Reoriented Strokes

Preview Window

Hint: You can apply one of the ready-to-use Presets.

Step 4. Press the button  to convert the entire image into a watercolor painting with the selected settings. To

interrupt the process, click the Stop button right to the progress bar.
Step 5. In the Classic Watercolor style, for the advanced licenses (Home Deluxe/Business), it is possible to refine the
result of the automatic conversion using the Stroke Direction tool  that helps to change the direction of the

strokes.

Draw guiding lines and click  to re-process the image.

Step 6. To make your work of art even more realistic and truly impressive, you can use the Decoration options:
Canvas, Frame, and Text.

Hint: The order of the application of the decoration effects depends on the position of the tabs. Drag the tabs to
change the order.

AKVIS Watercolor
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Watercolor Painting + Canvas

Step 7. If you like your new settings, you can save them as a Preset and use them later. Type a name for the preset
into the Presets field and press Save. When a new preset is created, it will be available in all tabs and will contain
their settings.

Click the heart icon to add the preset to Favorites or to remove it from this group of presets.

Learn more about the Watercolor Presets.

Step 8. You can put the finishing touches to your watercolor painting with the Post-Processing Tools , , , 

 available under the Home Deluxe/Business licenses, in the After tab.

Attention! Use these tools at the final step. If you run the processing  again, the changes made with the

tools will be lost!

Step 9. In the standalone version, you can print your watercolor painting with . In the plugin version, use the print

options in your graphics editor.
Step 10. Save the processed image.

- If you work with the standalone edition:

Click  to open the Save As dialog box. You can use the hot-keys: Ctrl+S  on Windows, ⌘ +S  on Mac.

Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

Click  to apply the result and close the plugin window. The AKVIS Watercolor plugin will close and the

picture will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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Watercolor from Photo
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Classic Watercolor Contour Watercolor

WATERCOLOR PAINTING EFFECT

AKVIS Watercolor turns your photos into watercolor paintings. The program allows you to create your own masterpiece in
just a few mouse clicks.

You can select a style of watercolor painting adjust the effect parameters in the Settings Panel, in the Painting tab.

The program includes two styles of photo to painting conversion: Classic Watercolor and Contour Watercolor. Each style
comes with a wide range of ready-to-use watercolor presets.

The Classic Watercolor style allows you to create aquarelle arts with transparent paints. Due to the variety of settings, the
program can imitate various painting techniques.

The Contour Watercolor style imitates a mixed method of painting, very close to the "dry-on-wet" watercolor technique. It
adds thin lines to the painting to emphasize the edge of objects and allows you to simulate a combination of watercolor paint
and pencils. The colors in such drawings are more vibrant and less blurred and the result may look like gouache or poster art.

Experiment with each effect and choose the best for your image.
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Classic Watercolor Contour Watercolor

 

Note: The Classic Watercolor style also includes the Stroke Direction tool  that helps to change the direction of the

generated brush strokes. The other tools are available for both styles.
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White Paper Rosy Paper

CLASSIC WATERCOLOR

The Classic Watercolor style in the program creates aquarelle arts with transparent paints. Due to the variety of settings,
the program can imitate various painting techniques.

Watercolor Painting from Photo
(Classic Watercolor)

Effect Parameters:

Paper Color. The parameter determines the color of the paper. Double-click the color plate and select the color.

Stroke Thickness (1-100). The parameter adjusts the width of the brush strokes.
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Stroke Thickness = 10 Stroke Thickness = 40

Max Stroke Length = 40 Max Stroke Length = 160

Dry Brush = 15 Dry Brush = 85

Simplicity = 5 Simplicity = 50

Max Stroke Length (1-200). The parameter defines the maximum stroke length.

Dry Brush (0-100). Increase the parameter value to simulate the Dry Brush painting technique. It reduces the smoothness
of strokes and reveals the brush texture. The lower the value, the more flowing the strokes appear.

Simplicity (1-100). The parameter regulates the simplification of the image. The higher the value, the more details are
smeared and softened.

Stroke Density (0-100). The parameter defines the amount of paint in a brush stroke. The lower values give more
transparent and luminous strokes.
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Stroke Density = 20 Stroke Density = 80

Dispersion = 10 Dispersion = 90

Saturation = 10 Saturation = 90

Edge Smoothness = 20 Edge Smoothness = 80

Dispersion (0-100). The parameter randomly changes the direction and width of strokes.

Saturation (-100..100). This parameter defines the color intensity of the brush strokes.

Edge Smoothness (0-100). The parameter sets the softness of the stroke edges. High parameter values imitate the "wet-
on-wet" technique by smoothing the transitions between strokes and creating fuzzy edges. At lower values the edges of
strokes are rough and sharp.

Lightening (0-100). The parameter allows you to lighten the image. Use it for dark photos to make the colors appear
translucent and luminous.
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Without Lightening Lightening = 70

Random Seed. This is the starting number for the random number generator that defines the distribution of strokes. It can
be any number between 0 and 9999. Every number corresponds to a particular strokes distribution (provided all other
parameters stay the same).

Random Arrangement of Strokes

 

CONTOUR WATERCOLOR
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Simplicity = 0 Simplicity = 10

CONTOUR WATERCOLOR

The Contour Watercolor style in the program imitates a mixed method of painting, very close to the "dry-on-wet"
watercolor technique. It adds thin lines to the painting to emphasize the edge of objects and allows you to simulate a
combination of watercolor paint and pencils. The colors in such drawings are more vibrant and less blurred and the result may
look like gouache or poster art.

Watercolor Painting from Photo
(Contour Watercolor)

Effect Parameters:

Image Group:

Simplicity. The simplification of the image. The higher the value, the more details disappear.

Uniformity. The unevenness, blending, and blurring of the painted areas.

AKVIS Watercolor

32



Uniformity = 1 Uniformity = 80

Density = 0 Density = 70

Size = 1 Size = 15

Density. The amount of brush strokes and paint layers.

Strokes Group:

Size. The size of the brush strokes.

Brightness. The amount and intensity of paint in the stroke. At low values, the white background shows through paints.
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Brightness = 10 Brightness = 60

Blur = 2 Blur = 16

Thickness = 15 Thickness = 30

Blur. The degree of spreading and smearing the brush strokes.

Contours Group:

Thickness. The width of contours.

Sensitivity. The intensity of the contour lines.
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Sensitivity = 1 Sensitivity = 20

Also, you can add casual effects to the distribution of the watercolor strokes:

Random Seed (0-9999). An element of randomness in the arrangement of the brush strokes.
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Color = 0 Color = 40

Saturation = 5 Saturation = 50

ABSTRACT ART

Using the Abstract Art tab you can change the shape and color of objects, giving them a unique and fantastic look.

Note: This tab is available only for Home Deluxe and Business licenses.

Abstract Art Tab

 

The parameters are divided into three groups:

Strokes Group. The parameters change the color of strokes in the resulting image.

Color (0-50). The higher the value, the more strokes are recolored and the more colors appear in the image.

Saturation (0-50). The parameter increases the brightness of random strokes. The default value is 0.
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Contrast = 10 Contrast = 50

Contrast (0-50). The parameter makes random strokes darker/lighter.

 

Correction Group. The parameters change the color of the original image.

Hue (-180...180). The parameter shifts all colors by the same hue value.

Hue = -50 Hue = 50

Saturation = -65 Saturation = 65

Brightness = -50 Brightness = 50

Saturation (-100...100). The parameter lets toning the image with brighter colors. It allows you to change the
intensity of colors: from neutral gray tones to bright colors.

Brightness (-100...100). The luminance of the image. At higher values the image is brighter while at lower values it is
darker.

AKVIS Watercolor

37



Strength = 10 Strength = 50

Curvature = 5 Curvature = 20

 

Distortion Group. The parameters change the shapes and proportions of the objects.

Strength (0-100). The amount the objects in the image are shifted and stretched. At a value of 0, there is no
distortion.

Curvature (2-25). This parameter increases the waviness of contours.

Random Seed (1-9999). This is the starting number for the random number generator that defines the deformation of shapes
and randomly combines strokes.

Random Distortions
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Toolbar, Before tab Toolbar, After tab

TOOLS IN AKVIS WATERCOLOR

In the AKVIS Watercolor toolbar, different tools become visible depending on the active tab, Before or After.

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and
additional tools (Before and After tabs).

Hint:
You can use the buttons  and  to undo/redo the operations made with the tools: , , , , , .

 

Pre-Processing Tools (on the Before tab):

Quick Preview  switches on/off the preview window. It is a square frame outlined with the "marching ants" that

displays changes made in the Painting and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you
quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the
original picture, click and keep mouse pressed within the preview area.

Preview Window

You can adjust the preview window size in the program's preferences .

 

Crop  (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want

to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and
contrariwise.

Note: This tool is applied to the original image! Use it before the watercolor effect.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit

the tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.
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Automatic Strokes Guiding Lines Changing Direction

Crop Image

Adjust the crop options:

You can choose the size of the crop rectangle from the Ratio drop-down list or enter your custom aspect ratio.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

 

Stroke Direction  gives you full control over the strokes. With this technique you can achieve truly realistic

paintings with human hair, patterns, and textures going in the right direction.

Note: This feature is only available in the Classic Watercolor style, for the advanced licenses (Home Deluxe,
Business).

Add the guiding lines with this tool, and the program will re-make the painting following the new direction. The changes
will be shown in the preview window. To re-start the image processing click .

 

Hint: You can save  and load  the guiding lines created with this tool.

Loaded lines automatically adapt to the image size.
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Watercolor Painting Effect Using Smudge

Eraser  lets you edit and remove the guiding lines drawn with the Stroke Direction tool . The size of the eraser

can be adjusted by right clicking on the image.

 

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The tools , , ,  are only available under the Home Deluxe/Business licenses, on the After tab.

Use them at the final step. If you re-run the image processing , the changes made with the post-processing tools

will be lost!

The tools' options are shown in a pop-up box which appears after right-clicking in the image.

Smudge  is designed for mixing colors in the picture and removing irregularities.

The tool's parameters:

Size (1-300). The maximum width of a line drawn with the tool.

Hardness (0-100). The amount of blurriness of the outer edge. The higher the value, the harder the brush edge
is.

Strength (1-100). The intensity of smearing the paint in the stroke. The higher the value, the more color is
smeared.

 

Blur . This tool creates a blur effect by reducing the color contrast between adjacent pixels.

The tool's parameters:

Size (1-200). The maximum width of a line drawn with the tool.

Hardness (0-100). The amount of blurriness of the outer edge. The higher the value, the harder the brush edge
is.

Radius (0.1-10.0). The higher the value of the parameter, the stronger the effect is.
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Watercolor Painting Effect Using Blur

Watercolor Effect Using History Brush

 

History Brush  lets you fade the watercolor effect and restore the image to its original state. You can choose the

mode of the tool: edit all changes or only brushes keeping the effect.

The tool's parameters:

Restore to Original. If the check-box is enabled, the tool lets weakening the watercolor effect, as well as the
result of the post-processing brushes. If the check-box is disabled, the tool edits only these brushes but does
not affect the watercolor effect.

Size (1-1000). The maximum width of a line made by the brush.

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges
become. At value 100% the border between the brush's edges and the background is very distinct; at lower
values the transition between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration
and more blending with the effect; at value 100% the original image will be restored more completely.

Watercolor Brush . The tool lets you draw translucent watercolor strokes.
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Hardness = 10 Hardness = 90

Strength = 35 Strength = 90

Wetness = 35 Wetness = 85

Size (5-1000). The maximum line width which can be drawn with the tool.

Hardness (0-100). The hardness of the outer edge. The higher the value, the harder the edge of the tool is.

Strength (1-100). The opacity of strokes.

Wetness (0-100). The amount of water in the stroke. The higher the value, the more transparent the inner part
of the stroke is and the more visible the edges become.

Color. Click the button to activate the Eyedropper tool that allows you to pick a color from the image. You can
also use the I -key.

Around the eyedropper's tip over the image you will see a color ring with the adjacent tints:

Eyedropper

1. Gradient line with the current color in the center. On the left side is
+30% black, and on the right side +30% white.

2. The previously selected color.
3. The current color of the pixel where the cursor is.
4. Colors of surrounding pixels.
5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101

px.
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The color ring helps you to select colors more precisely. If it's hard to catch a certain color, you can select a tint
on the ring with the Ctrl -key.

Double click the square button to choose a color from the Select Color dialog.

 

Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it, click the

icon, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction.
The hot-key is H .

Double-clicking on the tool's icon  on the Toolbar makes the image fit the window.

Zoom  lets you change the image's scale. To zoom in left click in the image. To zoom out left click with Alt  on the

image. The hot-key is Z .

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).
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WATERCOLOR ON CANVAS

AKVIS Watercolor turns ordinary photos into amazingly realistic aquarelle art. The painting can look even more vivid by
adding a paper texture. You can try a variety of surfaces: watercolor paper, porous blotting paper, classic canvas or even
unconventional materials like MDF board, brick wall, and others.

In the Decoration group switch to the Canvas tab to choose and adjust a texture for your artwork. Enable the Use Canvas
check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Watercolor on a Textured Paper

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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FRAMES FOR A WATERCOLOR PAINTING

In AKVIS Watercolor you can also add a frame to your watercolor painting to create a real work of art.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Frame

 

You can apply these frames to your watercolor art:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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ADD TEXT/WATERMARK TO A WATERCOLOR ART

In AKVIS Watercolor you can sign or watermark your newly created work of art.

Select Decoration -> Text to apply an inscription to your watercolor painting. By default, the parameters of the tab are
disabled. Enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Painting with Inscription

You can add any text or image.

Adjust the text/watermark settings.
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WATERCOLOR EFFECT PRESETS

AKVIS Watercolor includes a number of ready-to-use Presets which help you start working and create amazing artworks
with the watercolor technique.

When moving a cursor over a preset in the drop-down list, above the settings, the quick result appears in the small window
near the list.

A preset contains the settings for all tabs (Painting/Abstract Art/Decoration).

The AKVIS presets marked with * (for example, AKVIS Blossom*) use the Abstract Art parameters available only for the
Deluxe/Business licenses. In the Home version, these additional effects will not be applied, such presets will use with only
Painting and Decoration settings.

To create a preset, adjust the settings, type a name into the field, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete a user preset, choose it from the list and press Delete.

The AKVIS built-in presets cannot be removed.

 

Next to the preset name field there is a heart icon. Click it to add the selected preset to Favorites or to remove it from this
group of presets.

 

Presets Gallery

Click the Presets button in the top panel to switch to the visual display mode of presets with the real-time approximate
preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an image is
loaded into the program, preset thumbnails are generated.

Click a thumbnail to select the preset. Double-click the thumbnail to process the entire image.

Double-click the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list;

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);

 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.

 

You can save your presets to a .watercolor file with . To load presets from the file use .
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Read more how to import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box that looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;

- 100%. The actual size is used, the image doesn't scale.

Preview Window Size. Choose the desired value for the size of the quick preview window: from 200 х 200 px to 1,000 
х 1,000 px.
Processing Size Limit. Image processing is a very time-consuming operation. This parameter accelerates image
processing by temporarily reducing the size of the image to be processed. When the file size (in megapixels) does not
exceed the defined value, the image is processed in the usual way. If the loaded file is larger, the program will reduce
the image, process it, and enlarge it again to the initial size.
Recent Files (available only in the standalone version). The parameter sets the number of recent files, sorted by time,
displayed in the list by right-clicking on  (maximum: 30 files).

Hints. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To apply changes made in the Preferences window press OK.

If you need, click the Default button to reset to the default settings.
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BATCH PROCESSING

AKVIS Watercolor supports the Batch Processing feature that lets you automatically convert a series of images with the
same settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a
booklet or when processing all frames of video.

 

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of AKVIS Watercolor, read the instructions here.

If you use the Watercolor plugin in Photoshop or other image editors, follow this tutorial.
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PRINT IMAGES IN AKVIS WATERCOLOR

In the standalone version of AKVIS Watercolor you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Watercolor

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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DELICATE COLORFUL PAINTING: COMBINED EFFECT (WATERCOLOR + SKETCH)

The author of this example is Greg Collins.

AKVIS Watercolor allows you to create beautiful paintings that can be even more picturesque when combined with other
artistic effects. This tutorial shows how to get a stunning watercolor effect using AKVIS Watercolor, AKVIS Sketch, and
the AliveColors graphics editor.

Watercolor Painting Effect
(open a larger version)

Step 1. Open the image in AKVIS Watercolor using the button .
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Original Image

Step 2. Choose the AKVIS Meringue preset and run the processing by clicking .

The result is a washed painting that will be used as the base image.
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Workspace of AKVIS Watercolor

Save the result by clicking .

Step 3. Choose the AKVIS Tangerine preset and run the processing by clicking .

The result is a more detailed painting, portions of which will be combined with the previous rendering.
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Workspace of AKVIS Watercolor

Save the result by clicking .

Step 4. Open the image in AKVIS Sketch.

Workspace of AKVIS Sketch

Step 5. Choose the AKVIS Rough Sketch preset in the Classic style, modify the preset with the following settings,
and run the processing by clicking .
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Sketch Settings

The result is a light sketch that will be used to add definition to the watercolor painting.

Light Sketch

Step 6. Choose the fourth version of the drawing from the Timeline, and then save the result by clicking .

Timeline in AKVIS Sketch

Step 7. Open each of the Meringue, Tangerine, and Sketch renderings in AliveColors.
Step 8. Choose the tab with the Tangerine image, copy the whole image and paste it as a new layer in the Meringue
tab. Rename the layer “Tangerine”.

Step 9. Choose the Color Brush tool by clicking , and set the foreground color to white .

Step 10. From the Layers menu, add a Hide All layer mask to the “Tangerine” layer, and then click the Layer Mask
Thumbnail on the “Tangerine” layer to activate the mask.
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Layers

Step 11. Paint on the mask to reveal detailed portions of the Tangerine painting that you want to show.

Painting on the Mask

Step 12. Select the Layer Thumbnail on the “Tangerine” layer to leave the mask.
Step 13. Choose the tab with the Sketch image, copy the whole image and paste it as a new layer in the Meringue
tab. Rename the layer “Rough Sketch”. Choose the Multiply layer style, and then reduce the Opacity to 75.
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Adding Sketch Layer

The painting is nearly finished. There are some additional refinements that will make it look even more amazing.

Step 14. Add a real watercolor texture (many available for free on the Internet, best if grayscale) layer, choose the
Overlay layer style, and reduce the Opacity to what looks good to you (for example, 60).

Watercolor Texture

Step 15. Add a real watercolor paper texture (best if grayscale) layer, choose the Multiply layer style, and adjust the
Opacity (you can leave it = 100).
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Watercolor Paper Texture

Step 16. Add a text layer and place your signature on the finished painting.

Signature Layer

Step 17. From the File menu, choose Save to save your layered file into a .AKVIS or .PSD format. Then save it again
as a JPG file for sharing.
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Watercolor with Additional Refinements
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PORTRAIT IN WATERCOLOR: HARMONY OF BLUR AND DETAIL

AKVIS Watercolor turns digital photographs into gorgeous aquarelle paintings. But sometimes specific parts of the resulting
watercolor painting are not as detailed/washed out as you wish.

In this tutorial, you will learn how to make your subject stand out by mixing a detailed foreground and a blurred background.
This method is especially suitable when processing portrait shots that require a fine detailing of facial features.

Watercolor Painting Effect
(open a larger version)

Step 1. Open the image in AKVIS Watercolor using the button .
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Program Window of Watercolor

Step 2. Use the following photo-to-painting parameters:

Parameters: Set 1

Run the processing by pressing .

The facial features look good but the background and hair could be more blurry. This would make the painting more
picturesque. Follow the steps to improve the result.
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Result 1

Firstly, save the current result by clicking on .

Step 3. Open the image you just saved using the button .

Adjust the effect parameters as follows and run the processing by pressing .

Parameters: Set 2
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This time, the facial features look too blurry but the background and hair are exactly what is needed.

Result 2

Step 4. Now we need to combine the best parts of both processing results. Use the History Brush tool  to restore

the facial features.

Combining Processing Results

Step 5. Save the result.
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SAKURA IN BLOOM: COMBINING WATERCOLOR & SKETCH TECHNIQUES

AKVIS artistic programs allow you to turn digital photos into paintings in various techniques. You can further expand your
creative possibilities by combining various effects in one image.

Read the tutorial to learn how to create an adorable illustration using AKVIS Watercolor, AKVIS Sketch, and AliveColors
image editor. Get inspired and experiment with AKVIS programs!

Watercolor + Sketch Effects
(open a larger version)

Step 1. Open your image in AliveColors image editor. You can use the free version of the software.
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Program Window of AliveColors

Step 2. Duplicate the background layer using the Layers -> Duplicate command.

Duplicate Layers

Background Copy

Step 3. Transform the underlying layer to the watercolor painting in AKVIS Watercolor. Enable the Background layer
and call the Watercolor plugin from the effects menu: Effects -> AKVIS -> Watercolor.
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Choose any preset (we've chosen AKVIS Default) and run the processing by clicking on . Click  to apply the

changes.

Program Window of AKVIS Watercolor

Step 4. Turn the upper layer into the pencil drawing in AKVIS Sketch. Enable the Background copy layer and call the
Sketch plugin from the effects menu: Effects -> AKVIS -> Sketch.

Choose any preset (we've chosen AKVIS Charcoal High) and run the processing by clicking on . Click  t o

apply the changes.

Program Window of AKVIS Sketch

Step 5. Select the upper layer and change the blending mode to Multiply. Decrease the Opacity to 70.
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Multiply Mode

Step 6. You can remove superfluous pencil lines using the layer mask. Select the upper layer and press the button New
Mask . After pressing the button, an extra thumbnail appears to the right of the layer thumbnail.

Select the mask thumbnail. Paint with black over the mask to hide parts of the layer. Paint with white to display parts
of the layer.

Layer Mask

Step 7. Merge the layers (Layers -> Merge All) and save the result.
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SAILING SHIP: WATERCOLOR PAINTING

AKVIS Watercolor turns photos into vibrant aquarelle paintings.

Seascapes or marine paintings are filled with the light and color, typically depicting stormy scenes and epic shipwrecks. Read
the tutorial to learn how to create your own watercolor seascape!

Original Image Result

Step 1. Launch the AKVIS Watercolor software. Open an image.

Original Image

Step 2. Using the Quick Preview window adjust the effect parameters (or apply the default settings). If the image looks
dark, increase the Lightening parameter value in order not to lose the exceptional luminosity of watercolor paints.
Start the image processing by clicking on .
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Program Window of AKVIS Watercolor

Step 3. You can change the direction of strokes using the Stroke Direction tool . Note that this feature is only

available in Home Deluxe and Business licenses. Select the tool and draw several horizontal guiding lines in the sky.

Guiding Lines

Step 4. To achieve a more lifelike effect, add a paper texture and a vignette simulating unpainted edges. The effects
are available in the Decoration tab.
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Adding Canvas and Frame

Step 5. Save the result.

Watercolor Painting
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WATERCOLOR GALLERY

Have a look at the gallery of works created using AKVIS Watercolor. All paintings were created from photographs and
illustrate the possibilities of the software.

To share your works with us, please send them at info@akvis.com. Create brilliant and inspiring works of art with AKVIS
Watercolor!

 

Watercolor paintings created by Paul Baggott:

Chain
(click to open in large size)

Copenhagen
(click to open in large size)
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Ironbridge
(click to open in large size)

Pisa
(click to open in large size)
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Southampton Yacht
(click to open in large size)

Spanish Steps
(click to open in large size)

AKVIS Watercolor

77

http://akvis.com/img/examples/watercolor/examples/watercolor/watercolor-gallery/pisa-r.jpg
http://akvis.com/img/examples/watercolor/examples/watercolor/watercolor-gallery/yacht-r.jpg
http://akvis.com/img/examples/watercolor/examples/watercolor/watercolor-gallery/spanish-steps-r.jpg


Tower Bridge
(click to open in large size)

Venice Yacht
(click to open in large size)
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Venice Canal
(click to open in large size)

Watercolor paintings created by Klaus Beyer using stock images:

Zaanse Schans
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Santorini (Watercolor + Sketch)

Apple Blossom

 

Here are some other photo-to-painting conversion examples:
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Festive Vibes

Magic Sunset
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Ballerinas

Dream of Spring
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Lake Sils, Switzerland

Shades Of Rose div>
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Portrait of a Girl

Azure Sky
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Winter Fun

Happy Bride
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Lavender Field
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture!
More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Change Image Size without Quality Loss

AKVIS Magnifier AI helps to resize images without loss in quality. Featuring neural networks based algorithms, Magnifier AI
enlarges digital pictures to super-high resolution and produces stunning wall-sized prints. More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
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includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…
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AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, and Maestro, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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